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Urm�rirea desf��ur�rii unui proiect cu mediul 
Microsoft Project 

 
INTRODUCERE 
 
Exist� multe situa�ii în care un manager este pus în situa�ia de a duce la bun sfâr�it 

activit��i foarte complexe, care implic�: 
 
� foarte multe subactivit��i; 
� o mare varietate de resurse; 
� foarte multe restric�ii �i dependen�e între resurse �i activit��i; 
� o echip� de lucru în care membrii au specializ�ri �i competen�e foarte variate; 
� respectarea a sute de termene de execu�ie; 
� încadrarea în buget �i ob�inerea la timp a banilor necesari; 
� foarte multe situa�ii neprev�zute sau incorect previzionate etc. 

 
Situa�ia de mai sus este foarte des întâlnit� în: 
 

• Construc�ii  
• Dezvoltare soft sau tehnic� de calcul  
• Construc�ii de ma�ini 
• Planificarea evenimentelor  
• Produc�ie de film  
• Logistic�  
• Publicitate  
• Implementarea noilor servicii sau produse etc.  

 
În aceste cazuri este vital ca la începutul proiectului s� se realizeze o bun�: 
� identificare a activit��ilor care trebuie efectuate; 
� identificare a intervalelor de timp în care trebuie efectuate acestea; 
� identificare a celor mai potrivi�i oameni pentru fiecare din activit��i; 
� delegarea de sarcini membrilor echipei; 
� evaluare a sumei de bani necesare proiectului. 

 
adic� o planificare eficient� a proiectului. 

Un management eficient cere apoi un continuu control al proiectului, în toate 
detaliile acestuia. Este necesar� o continu� urm�rire a evolu�iei proiectului, în ceea ce 
prive�te desf��urarea activit��ilor, încadrarea în bugetul alocat �i ob�inerea banilor la timp, 
asigurarea cu resurse �i atingerea obiectivelor urm�rite. În plus trebuie urm�rit� respectarea 
specifica�iilor de calitate, trebuie prev�zute metode de dep��ire a situa�iilor conflictuale sau 
care nu se încadreaz� în planul ini�ial, trebuie s� existe o comunicare efectiv� cu ceilal�i 
membrii ai echipei, precum �i cu clien�ii, furnizorii �i conducerea. 
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Microsoft Project este unul dintre cele mai utile softuri în sprijinirea conduc�torului 
de proiect �i a membrilor echipei în atingerea scopului pentru care este destinat proiectul. 

De�i exist� multe softuri prin care pute�i s� organiza�i activitatea, în sensul reg�sirii 
rapide a unei informa�ii, pentru ob�inerea unui raport la imprimant�, trimiterea lui prin e-
mail, publicarea pe o pagin� web etc., Microsoft Project fiind folosit în special pentru 
planificarea activit��ilor �i ob�inerea de rapoarte privind desf��urarea acestora, totu�i acest 
soft dep��e�te cu mult aceste cerin�e minime. Astfel, softul ofer� o gam� foarte larg� de 
reprezent�ri grafice privind situa�ia actual� sau istoricul desf��ur�rii activit��ilor, costurile 
implicate, profilul resurselor, structura proiectului, încadrarea în buget de-a lungul fiec�rei 
faze de execu�ie, ofer� posibilitatea înglob�rii unui volum imens de informa�ii în cadrul 
proiectului, ofer� posibilit��i de lucru în echip� deosebite, ofer� posibilitatea import�rii sau 
folosirii datelor dintr-un num�r foarte mare de aplica�ii externe, are un help impresionant, 
este u�or de folosit �i are o interfa�� prietenoas�, ofer� instrumente puternice de optimizare a 
desf��ur�rii proiectului etc. 

Toate acestea fac ca Microsoft Project s� fie una din primele op�iuni de soft utilitar 
în conducerea unui proiect. 

 
UTILIZARE 
 
Microsoft® Project face parte din colec�ia de programe din pachetul Microsoft 

Office, foarte multe din caracteristicile acestuia fiind comune cu celelalte programe, astfel 
încât orice utilizator al unuia din programele acestui pachet va putea înv��a cu u�urin�� �i 
acest program. 

Capitolul de fa�� este destinat descrierii posibilit��ilor de lucru cu interfa�a 
programului Microsoft Project. 

Caseta de dialog Project Information 

Dac� programul nu a fost pornit prin deschiderea unui fi�ier deja existent atunci 
acesta va crea automat un nou proiect �i va deschide la pornire caseta de dialog de mai jos, 
care con�ine câteva informa�ii generale despre proiect: 
 
 
 
 
 
 
 
 
 
 
 
 

În aceast� caset� pot fi introduse urm�toarele informa�ii: 

Figura 1. Caseta de dialog Project Information�

�
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� dac� programarea proiectului se va face relativ la începutul acestuia sau relativ 
la sfâr�itul acestuia; 

� data la care va începe proiectul (sau la care se va sfâr�i); 
� data curent�; 
� data de stare (este data fa�� de care se fac raport�rile privind progresul 

activit��ilor, costurile implicate, performan�ele atinse etc. În mod predefinit aceasta este data 
curenta) 

� Calendarul utilizat; 
� Prioritatea predefinit� a activit��ilor.  
 
Personalizarea meniurilor �i barelor cu instrumente 
Tranzitia meniurilor poate fi personalizat� din Tools - Customize – Toolbars – 

Options, a�a cum se vede în figura urm�toare: 
�

�

�

�

�

�

�

�

�

�

�

 

Ecranul Startup Task 

Ecranul Startup Task apare în zona din stânga a ferestrei programului când acesta 
este deschis prima dat� �i con�ine op�iunile de creare a fi�ierelor noi sau pentru a deschide 
fi�iere existente. 

Noul proiect poate fi început în mai multe moduri: 
 
� prin introducerea datelor de la zero, caz în care se folose�te Blank Project; 
� prin introducerea datelor de la zero, dar fiind asistat de program, caz în care se 

folose�te New From Wizard; 
� prin utilizarea unuia din template-urile propuse de program, caz în care se 

folose�te New From Template: 
Microsoft Project propune o mare varietate de scheme de proiect, dintre acestea 

amintind: 
� Construc�ii  

Figura 2. Caseta de dialog Customize�
�
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� Dezvoltare soft sau tehnic� de calcul  
� Construc�ii de ma�ini 
� Planificarea evenimentelor  
� Logistic�  
� Publicitate  
� Implementarea noilor servicii sau produse etc.  

� prin utilizarea unui proiect anterior, caz în care se folose�te New From Existing 
Project, 

 
a�a cum se vede în figura de mai jos: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
�

�

�

Bara View 
 
Bara View este similar� celei din Microsoft Outlook®. Ea con�ine setul de butoane 

prin care sunt apelate toate vederile programului referitoare la activit��i �i resurse. Cele mai 
importante sunt afi�ate în clar, celelalte pot fi apelate prin intermediul bunonului More Views 
aflat ultimul în bara View.  

Figura 3. Ecranul Startup task�

�
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Butoanele predefinit vizibile la afi�area acestei bare sunt cele corespunz�toare 
vederilor: 

� Reprezentarea proiectului prin afi�area zilelor tip Calendar; 
� Reprezentarea proiectului prin graficul Gantt; 
� Reprezentarea proiectului prin diagrama activitate-nod; 
� Lista de activit��i, fiecare cu resursele utiliate �i num�rul de ore zilnice prestate de 

fiec�re resurs�; 
� Graficul Gantt cu surprinderea modific�rilor din istoricul proiectului; 
� Profilul resurselor; 
� Tabelul resurselor; 
� Lista de resurse, pentru fiecare fiind listat� mul�imea de activit��i la care este 

utilizat� precum �i în ce m�sur� este utilizat�; 
� Butonul pentru apelarea uneia din celelalte vederi posibile;  
Vederea predefinit� este Gantt Chart, care con�ine dou� zone: una cu lista de 

activit��i ale proiectului �i cealalt� cu diagrama Gantt a proiectului. Pentru a ascunde sau a 
face vizibil� bara View se folose�te meniul View din care se bifeaz� sau debifeaz� linia View 
Bar. Când este vizibil�, butonul corespunz�tor vederii afi�ate este reprezentat ap�sat.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 �

Figura 4. Bara View�

a) Bara View ascuns� a) Bara View vizibil��
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Barele cu instrumente 
  
Patru dintre barele cu instrumente �i bara cu meniurile sunt vizibile predefinit la 

pornirea Microsoft Project. Cele patru bare cu instrumente sunt: 

� Bara Standard; 

� Bara Formatting; 

� Bara Task Pane; 

� Bara Project Guide.  

Bara cu meniuri este singura care nu poate fi ascuns�. Toate celelalte pot fi f�cute 
vizibile sau ascunse din meniul View, submeniul Toolbar în care barele vizibile au checkbox-
ul din stânga bifat. O bar� poate fi f�cut� vizibil� sau nu prin bifarea sau debifarea checkbox-
ului corespunz�tor. 

Pot fi create de asemenea si alte bare cu instrumente fie folosind succesiunea de 
meniuri Tools -> Customize -> Toolbars fie dând click dreapta pe o bara de instrumente �i 
alegând Customize. Butoanele de comand� ale noii bare se adaug� tr�gându-le cu mouse-ul 
din list� pân� deasupra noii bare.  

Noile bare pot fi folosite �i din alte proiecte utilizând pentru distribuirea acestora 
meniul Organizer din Tools. 

În figura de mai jos este reprezentat submeniul care apare la selectarea succesiv� a 
meniurilor View -> Toolbars. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  Figura 6. Barele cu instrumente 
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Meniurile principale din Microsoft Project 
 
Meniul File 

În figura de mai jos este reprezentat meniul File �i submeniurile acestuia, în 
parantezele p�trate fiind trecute variantele submeniului respectiv în func�ie de starea 
programului. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pentru  submeniul Send To, la apelare va ap�rea urm�torul submeniu: 
 
 
 
 

 
 
 
 
Se va utiliza comanda Mail Recipient pentru a trimite un e-mail direct din program, 

prin apelarea clientului de e-mail existent pe calculator �i comanda Route Recipient pentru a 
retransmite un e-mail.  

 
Meniul Edit 
 
În figura de mai jos este reprezentat meniul Edit împreun� cu submeniurile sale: 

Figura 7. Meniul File 
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Pentru  submeniul Fill, la apelare va ap�rea urm�torul submeniu: 
 

 

 
 
 
Acesta este utilizat pentru copierea con�inutului unei celule într-un num�r dorit de 

celule adiacente pornind de la aceasta în una din cele 4 direc�ii. 
Pentru  submeniul Clear, la apelare va ap�rea urm�torul submeniu: 
 
 
 
 
 
 
 
 
 
 
 

Figura 8. Meniul Edit 
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Pentru  submeniul OLE, la apelare va ap�rea urm�torul submeniu: 
 
 
 
 
 
Comenzile Cut, Copy, Delete or Clear se aplic� la o Celul�, Activitate, Resurs�, 

Atribuire sau Linie, în func�ie de ceea ce este selectat în momentul apel�rii acesteia sau în 
func�ie de vedea activ� (Task, Resource sau Usage) active. Comanda Delete Cells se aplic� 
de asemenea �i la por�iunea în care se seteaz� modul de afi�are al timpului din vederea 
Usage. 

Comanda Paste as Hyperlink creeaz� o leg�tur� la zona din care a fost copiat� 
informa�ia, dac� sursa suporta acest tip de leg�tur�. Informa�iile privitoare la aceste leg�turi 
sunt afi�ate în câmpurile Hyperlink, Hyperlink Address, Hyperlink SubAddress �i 
Hyperlink HREF. 

Din meniul Fill doar comenzile Down �i Up pot fi aplicate la tabele. Toate 
comenzile din acest submeniu se pot aplica la afi�area timpului din vederile de tip Usage. 

 
Meniul View 
�

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 9. Meniul View 
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Meniul View con�ine în prima parte lista cu toate vederile disponibile în bara View 
din stânga ecranului, încheiat� cu op�iunea de ascundere sau vizualizare a acesteia. 

La apelarea op�iunii Table [Current Table] va ap�rea submeniul de mai jos: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
În acest submeniu se afl� o list� cu grupurile predefinite de coloane care pot fi 

vizualizate în vederea Gantt Chart, în stânga reprezent�rii grafice a proiectului. Op�iunea 
predefinit� este Entry, în care se afl� coloanele: 

 
Indicators – este o coloan� în care vor fi plasate imagini care atrag aten�ia asupra 

activit��ilor aflate în situa�ii deosebite (de exemplu activit��ile de tip millestone, efectuate 
complet, cu constrângeri privind data de desf��urare etc); 

Task Name – con�ine denumirile activit��ilor; 
Duration – con�ine duratele activit��ilor; 
Start – con�inele datele de începere ale activit��ilor; 
Finish – con�ine datele de terminare ale activit��ilor; 
Predecessors – con�ine predecesorii imedia�i ai activit��ilor, precum �i tipurile de 

dependen�e �i întârzierile corespunz�toare dependen�elor; 
Resource Names – con�ine numele resurselor utilizate de fiecare activitate precum �i 

cantita�ile în care sunt utilizate. 
 
Toate aceste câmpuri pot fi utilizate atât pentru vizualizarea informa�iilor respective 

cât �i pentru modificarea sau introducerea acestora. 
Grupul de coloane vizibil la un moment dat este cel în dreptul c�ruia se afl� bifa din 

stânga listei, a�a cum se vede în figura de mai jos. Acest grup poate fi schimbat prin bifarea 
altei op�iuni (de exemplu Cost, caz în care vor ap�rea coloanele ce con�in informa�iile legate 
de costurile activit��ilor, Usage informa�ii legate de consumul de resurse etc). 

În orice caz, dac� nici una din grupele predefinite nu con�ine exact coloanele pe care 
le dori�i, pute�i oricând vizualiza sau ascunde o coloan� dând click dreapta pe heder-ul 

Figure 10. Grupurile predefinite de coloane vizibile 
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coloanelor �i alege Insert Column... moment în care va ap�rea o list� cu toate coloanele 
disponibile, din care pute�i alege spre vizualizare orice coloan� dori�i sau alege Hide 
Column, pentru a ascunde coloan� pe al c�rei header a�i dat click. 

 

 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Reports 
 
Prin apelarea acestui submeniu va ap�rea fereastra: 
 

 
 
 
 
 
 
 
 
 
 
 
din care pot fi ales grupul de rapoarte din care dori�i s� lista�i sau scoate�i la imprimant� un 
tip de raport: 

� Overview – grupul cu rapoarte ce con�in informa�ii generale sau globale despre 
proiect; 

� Current Activities – grupul de rapoarte privind desf��urarea sau stadiul 
activit��ilor; 

� Costs – cele legate de costuri; 
� Assigments – cele privind utilizarea resurselor pe activit��i; 
� Workload – repartizarea resurselor pe activit��i; 
� Custom – Utilizat pentru a ob�ine un raport personalizat  
 
 
 

Figure 11. Grupul de coloane predefinit 
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 Grupul activ este cel încadrat în chenarul negru, iar prin ap�sarea butonului Select  va 
ap�rea o fereastr� cu grupul de rapoarte de tipul respectiv, în figura de mai sus fiind dat� 
fereastra cu rapoartele predefinite de tip cost. 
 

Submeniul Toolbars este reprezentat în figura 6 �i a fost deja discutat. 
 
Submeniul Headers and Footers... va afi�a fereastra tab-ul Header din fereastra 

Page Setup, din acesta fiind alese informa�iile care vor fi printate la tip�rirea unui raport sau 
a unei vederi din program, la partea de sus a paginii în grupul Header sau în partea de jos, în 
grupul Footers. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Zoom con�ine un set de valori predefinite privind intervalul de timp care 

este vizibil în vederile programului, o op�iune prin care pot fi ar�tate toate activit��ile 
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selectate, una prin care poate fi v�zut tot proiectul precum �i op�iunea de a vedea num�rul 
exact de zile dorit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Meniul Insert 
În figura de mai jos este reprezentat meniul Insert cu toate submeniurile disponibile 

la desf��urarea maxim� a acestuia, precum �i diferitele op�iuni existente în cazul diferitelor 
vederi posibile: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Insert Task/Resource este utilizat pentru inserarea unei noi activit��i 

sau a unei noi resurse printre cele existente, varianta Task/Resource depinzând de vederea 
activ� la momentul respectiv. 
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La apelarea submeniului New Resource From vor ap�rea op�iunile: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

prin care pot fi importate date din diferite surse externe. 
 
Recurring Task 
 
Acest submeniu este utilizat pentru introducerea activit��ilor recurente, adic� acele 

activit��i care se petrec cu regularitate la anumite momente de timp sau intervale de timp, 
cum ar fi �edin�ele s�pt�mânale etc. 

Din fereastra care se deschide la apelarea acestui submeniu pot fi introduse 
informa�ii detaliate privind activitatea recurent� dorit�, legate de frecven�a acesteia, 
momentul din interval când se produce, de câte ori se efectueaz� sau pe ce interval de timp se 
efectueaz�, dup� ce calendar se desf��oar� etc. 
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La apelarea submeniului Insert Project se va deschide o fereastr� de tip explorer 
din care ve�i alege fi�ierul ce con�ine proiectul pe care dori�i s�-l insera�i ca subproiect în 
proiectul actual. 

La apelarea submeniului Insert Column se va deschide fereastra: 
 
 

 
 
 
 
 
 
 
din care pot fi ad�ugate coloane la vederea curent�. 

 
Insert/Remove/Remove all page break 

 
Separatorii de pagin� (page break) sunt cei care delimiteaz� zonele care vor fi 

printate pe foi separate. Microsoft Project insereaz� ace�ti separatori automat la printaredar ei 
pot fi introdu�i sau modifica�i �i manual �i sunt utiliza�i pentru a printa anumite informa�ii, ca 
de exemplu grupul de activit��i ale unui subproiect pe o aceea�i pagin� sau pentru a pozi�iona 
la începutul paginii titlurile etc. Separatorul este inserat deasupra liniei selectate. 

 
Sumbeniul Drawing este utilizat pentru inserarea de imagini vectorizate (linii, 

elipse, curbe, textbox-uri etc. în zonele cu reprezent�ri grafice din vederile care con�in astfel 
de por�iuni �i apelarea sa duce la afi�area barei cu butoane de desenare: 

 
 
 
 
Submeniul Object este utilizat pentru inserarea unor obiecte gen fi�iere grafice, 

fi�iere de sunet sau video, documente, table de calcul etc, la apelarea acestuia deschizându-se 
fereastra de mai jos din care poate fi selectat sau creat obiectul dorit: 
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Submeniul Hyperlink este utilizat la inserarea în proiect a adreselor la pagini web 
locale sau aflate pe servere web, la apelarea acestuia deschizându-se fereastra clasic� din 
suita MSOffice: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Meniul Format 
 
Con�ine op�iuni privind propriet��ile obiectelor din MSProject, cum ar fi forma sau 

aspectul acestora, valori, stiluri etc, în figura de mai jos fiind reprezentat� lista de meniuri 
din cadrul acestuia: 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figura 13. Meniu Format  
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Submeniul Format Font 
 
Cu ajutorul lui poate fi aleas tipul de font, stilul �i dimensiunea acestuia, culoarea �i 

posibilitatea sublinierii textului selectat. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Format Bar 
 
Este utilizat pentru personalizarea formei obiectelor prin care sunt reprezentate 

activit��ile în graficul Gantt, modific�rile privind atât forma acestora, din tabul Bar Shape, 
forma predefinit� fiind un dreptunghi, cât �i a textului afi�at în jurul acestora, din tab-ul Bar 
Text. 

 
 
 
 
 
 
 
 
 
 
 
Fiecare obiect este format din trei p�r�i dispuse pe orizontal� existând posibilitatea 

modific�rii oric�rei dintre acestea. 
 
Submeniul Format Timescale 
 
În toate vederile care prezint� evolu�ia proiectului în timp, în partea de sus a vederii 

se afl� o zon� cu informa�ii despre dat�. Aceast� zon� este format� din trei zone orizontale, 
în care pot fi alese trei unit��i de m�sur� pentru timp, de la cea mai mare în partea de sus 
pân� la cea mai mic� în cea de jos. Din acest submeniu pot fi alese unit��ile de timp pentru 
fiecare (pot fi vizualizate sau ascunse oricare dintre ele, poate fi aleas� modalitatea de 
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reprezentare a datei etc) �i poate fi aleas� o modalitate de reprezentare diferit� pentru zilele 
nelucr�toare, a�a cum se vede în figura de mai jos.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Format GridLines 
 
Din acest submeniu poate fi îmbun�t��it� afi�area anumitor vederi prin ad�ugarea 

unor linii orizontale de diferite tipuri �i culori, prin care s� poat� fi mai u�or de urm�rit 
pozi�iile relative ale obiectelor. 

 
 
 
 
 
 
 
 
 
 
 
 
Submeniu Gant Chart Wizard 
 
Din acest submeniu poate fi personalizat� forma graficului Gantt ce surprinde 

evolu�ia în timp a proiectului, prin activarea unui „vr�jitor” care în 5 pa�i succesivi v� va 
invita s� alege�i op�iunile prin care se ob�ine forma cea mai relevant� pentru dumneavoastr� a 
graficului Traking Gantt. 

Din cele cinci ferestre succesive vor fi alese op�iunile privind: 
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1. dac� vor fi vizualizate sau nu drumul critic �i salv�rile de tip baseline, 
precum �i aspectul vederii, fiind predefinite mai multe stiluri; 

2. dac� vor fi afi�ate sau nu nforma�iile despre termenele �i resursele 
activit��ilor, precum �i ce informa�ii vor fi afi�ate; 

3. dac� vor fi afi�ate sau nu dependen�ele dintre activit��i. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 1. 

4. 3. 

5. 
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Submeniul Text Styles 
 
Prezint� acelea�i op�iuni ca la formatarea fontului cu deosebirea c� op�iunile alese 

se vor aplica nu doar la textul selectat ci la un întreg set de informa�ii, gen denumirile 
subproiectelor, activit��ile critice etc, pentru scoaterea în eviden�� în mod special a acestora. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Bar Styles 
 
Acest submeniu este fa�� de Format Bar a�a cum este submeniului Font Styles fa�� 

de format Font, în sensul c� de aici vor fi reprezentate sub o form� deosebit� nu denumirile 
activit��ilor pe care dorim s� le scoatem în eviden�� ci forma b�rilor corespunz�toare, a�a 
cum se vede în figura de mai jos:  
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Submeniul Format Layout 
Este utilizat pentru alegerea op�iunilor privind forma reprezent�rii dependen�elor 

dintre activit��i, formatul datei etc, a�a cum se vede în figura de mai jos: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Drawing este utilizat pentru ordonarea pe layere a obiectelor grafice �i 

este dat în figura de mai jos: 
 
 
 
 
 
 
 
Submeniul Layout Now este disponibil� doar în vederea Calendar. Acesta este 

utilizat când este necesar un refresh al vederii dup� ce au fost schimbate format�rile acesteia. 
 
Forma submeniului Details difer� în func�ia de vederea activ�, mai jos fiind listate 

formele posibile ale acestuia:  
 
 
 
 
 
 
 
 
 
 
 Task Form Task Usage Resource Form 
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Meniul Tools 
 
Meniul Tools este reprezentat în figura de mai jos, cu toate op�iunile vizibile: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resource Usage Resource Graph 

Figura 15. Meniul Tools 
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Submeniul Spelling este cel clasic din suita MSOffice �i serve�te la verificare 
corectitudinii gramaticale a cuvintelor din proiect, existând posibilitatea utiliz�rii de 
dic�ionare pentru diferite limbaje, programul propunând posibilele variante corecte în 
momentul  când g�se�te un cuvânt care nu este în dic�ionar. Verificarea se poate face 
automat de program sau la cerere prin intermediul acestui submeniu. 

 
 
 
 
 
 
 
 
 
 
 
 
AutoCorrect 
 
Submeniul AutoCorrect este de asemenea cel clasic: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Link Between Project 
 
 
Submeniul Links Between Projects permite vizualizarea �i modificarea 

dependen�elor dintre activit��ile proiectului �i activit��i din proiecte externe. Introducerea 
acestor dependen�e se face din submeniul Task Informations, tab-ul Predecessors. 
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Change Work Time 
 
 
 
 
Submeniul Change Working Time este utilizat pentru definirea calendarului de 

lucru al activit��ilor. De aici se pot defini toate programele de lucru existente în proiect, 
putându-se defini câte un program pentru fiecare activitate �i fiecare resurs�, calendarele 
definite putând fi apelate din tab-ul Advanced din Task Information pentru activit��i sau 
sau din vederea Resource Sheet pentru resurse. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Assign Resources 
 
 
Submeniul Assign Resources este utilizat pentru atribuirea rapid� a resurselor la 

activit��i, existând posibilitatea aloc�rii mai multor resurse simultan, pe grupuri, din anumite 
categorii etc. 

La apelarea acestui submeniu este deschis� fereastra de mai jos din care vor fi 
efectuate aceste atribuiri. 
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Submeniul Resource Leveling  este una dintre cele mai puternice op�iuni a 

programului, de aici putându-se optimiza desf��urarea proiectului, în condi�iile încadr�rii în 
limitele disponibilului de resurse. Acest meniu r�spunde la problema g�sirii acelei 
program�ri a resurselor prin care se consum� din fiecare resurs� în fiecare zi în limitele 
existente, astfel încât proiectul s� se termine în timpul minim posibil. Aceast� optimizare se 
poate face automat de program sau la cerere din acest submeniu. Ac�iunea se aplic� de la 
data curent�. 
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Submeniul Resource Sharing este utilizat pentru utilizarea de resurse din alte 
proiecte sau aducerea la zi a informa�iilor despre acestea. La apelarea acestuia se deschide 
lista de op�iuni:  

 
 

 
 

la apelarea op�iuni Share Resources ap�rând fereastra: 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Traking este cel din care putem aduce evolu�ia programului la data 

curent� sau putem simula evolu�ia pân� la o anumit� dat� �i de asemenea putem face 
salv�rile de tip baseline sau proiect intermediar. Pot fi f�cute pân� la 10 salv�ri de tip 
baseline �i pân� la zece de tip proiect intermediar. 

  
 

 
 
 
 
 
 
Submeniul Macro este cel clasic din suita MSOffice �i este utilizat la stabilirea 

restric�iilor asupra utiliz�rii codului din alte programe în proiect sau pentru scrierea de noi 
instruc�iuni în mediul Visual Basic. 
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Submeniul Customize este utilizat pentru personalizarea b�rilor cu instrumente sau 
pentru modificarea formularelor standard prin care se introduc datele despre activit��i, 
resurse sau aloc�ri. 

 
 

 
 
 
 
 
 

Submeniul Project 
În desenul de mai jos este afi�at� lista de op�iuni din meniul Project. 
 

 
Submeniul Sort 

Din acest submeniu poate fi schimbat� ordinea de afi�are a activit��ilor sau 
resurselor în func�ie de criteriile dorite, forma acestuia depinzând de vederea curent�, a�a 
cum se vede în figura de mai jos: 

 
 
 
 
 
 
 
 
 
 

La resurse 

La activit��i 
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Submeniul Filtered este utilizat pentru filtrarea listei de activit��i sau resurse dup� 
criteriile dorite de dumneavoastr�, în sensul afi��rii doar a celor relevante la un moment dat. 
Exist� un set de filtre predefinite dar pot fi create �i filtre personalizate din op�iunea More 
Filters. Forma acestui submeniu depinde de vederea activ�, a�a cum se vede din figura de 
mai jos: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submeniul Group by este utilizat pentru gruparea activit��ilor de acela�i tip în liste 

separate, forma acestui submeniu depinzând de asemenea de vedea activ�: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

La activit��i La resurse 

La activit��i La resurse 
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Submeniul Outline este utilizat pentru structurarea activit��ilor pe subproiecte, 
putându-se ascunde sau vizualiza activit��ile unui subproiect, aloc�rile resurselor pe activit��i 
etc, a�a cum se vede în figura de mai jos: 

 
 
 
 
 
 
 
 
 
 
 
Op�iunea Hide/Show Assignments este disponibil� doar în vederile de tip Usaje iar 

op�iunile Show/Hide Assignments �i Show/Hide Outline Symbols sunt sincronizate. 
 
Submeniul WBS (work break structure) este utilizat pentru memorarea structurii 

proiectului, el putând fi utilizat în forma prestabilit� de program sau putându-se crea un mod 
de ierarhizare propriu, din acest submeniu.  

 
 
 
 
 
În figura de mai jos este ar�tat� fereastra din care se define�te forma dorit� a 

codului: 
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Task information 
 
Submeniul Task Information este utilizat pentru introducerea informa�iilor 

detaliate despre o activitate, acestea fiind grupate în mai multe categorii, a�a cum se vede în 
desenul de mai jos: 

1. Informa�ii generale (durata, data de începere �i de terminare etc) 
2. Informa�ii despre dependen�ele de celelalte activit��i; 
3. Resursele folosite; 
4. Informa�ii avansate (deadline, constrângeri, tip, calendar, cod WBS etc.) 
5. Note (Pot fi accesate direct din submeniul Task Notes...); 
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Submeniul Project Information 
�

Con�ine informa�iile generale despre proiect: 
� daca este programat fa�� de data de începere sau fa�� de cea de terminare; 
� data de începere �i de terminare; 
� data de stare (fa�� de care se fac rapoartele); 
� prioritatea predefinit� a activit��ilor; 
� statistica privind costul total, num�rul de ore de munc� total, cât s-a efectuat deja 

etc. 
 
 
 
 
 
 
 
 
 
 
La ap�sarea butonului Statistics... apare fereastra cu datele sintetice: 
 
 
 
 
 
 
 
 
 
 
 
 
 
� �� �� ��	 
 ���� 
 ��� �� � � � �

 
Este utilizat pentru lucrul în echip� a mai multor persoane la acela�i proiect prin 

intermediul serverului MSProject sau prin intermediul serviciului de e-mail. 
Din acest mediu poate fi definit serverul prin intermediul c�ruia se colaboreaz�, , se 

pot accesa baze de date cu resurse sau activit��i, se pot publica pe internet, prin crearea de 
pagini web a informa�iilor din proiect, se pot �ine �i accesa informa�iile în documente 
comune etc. 

Lista de op�iuni a meniului Collaborate este dat� în figura de mai jos: 
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În figura de mai jos este prezentat� lista de op�iuni disponibil� în submeniul 

Publish, con�inând informa�iile care pot fi publicate pe internet prin crearea unei pagini web 
cu datele alese din acest submeniu: 

 
 
 
 
 
 
 
 
La apelarea submeniului Collaborate Options apare fereastra cu op�iuni generale 

despre proiect având activ tab-ul Collaborate din care se va defini serverul prin care se face 
colaborarea sau se poate opta pentru colaborare prin e-mail, dac� nu exist� un astfel de 
server. 

�
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Meniul Window  
 
Con�ine op�iunile standard din suita MSOffice, din acest meniu putând alege modul 

în care sunt aranjate pe ecran ferestrele proiectelor deschise, dac� s� fie vizibile sau nu �i 
lista de proiecte deschise cu op�iunea alegerii celui care s� fie în top. 

 
 
 
 
 
 
 
 
 
 
 
 
Op�iunea care difer� de cele clasice este Split/Remove Split prin care se utilizeaz� 

posibilitatea de a vedea în acela�i ecran dou� vederi, perechile fiind predefinite, cea de a 
doua zon� con�inând informa�ii detaliate despre obiectele din prima, a�a cum se vede în 
exemplul de mai jos, ob�inut prin splitarea vederii Gantt Chart: 
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Meniul Help 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MSProject ofer� un help extrem de sofisticat, cu toate informa�iile necesare pentru 

în�elegerea filozofiei conducerii unui proiect, pentru încadrarea exact� a posibilit��ilor 
programului, pentru descrierea obiectelor etc, pentru aceasta fiind prev�zute mai multe 
modalit��i de lucru: 

 
1. Help-ul clasic: 
 

 



PHARE 2000 – Coeziune Economic� �i Social� 

 

35

2. Asistentul MSOffice 
 
 
 
 
 
 
 
 
 
 
 
3. Harta proiectului 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Un manual cu metodologia conducerii unui proiect 
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5. „Vr�jitorul” care v� va conduce prin toate etapele construirii unui proiect: 
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Crearea �i managementul unui proiect cu utilitarul  
MICROSOFT   PROJECT   2002 

 
A. Crearea unui proiect 
 
Pasul 1. Pentru ini�ierea unui nou proiect se tasteaz� 
Da�i clic pe butonul New  aflat pe bara de instrumente Standard sau din meniul 

File → New. 
Va ap�rea c�su�a de dialog: 
 
 
 
 
 
 
 
 
 
 

în care se introduc data de start sau data de sfâr�it dorit� a proiectului, dup� cum a fost 
aleas� op�iunea în linia Schedule from: (planific� fa�� de:). 

Observa�ie: Chiar dac� nu o face�i acum sau vre�i s� le modifica�i ulterior, pute�i 
face aceasta oricând din meniul Project → Project Information. 

 
Pasul 2. Se introduc titlul proiectului, subiectul proiectului, autorul proiectului, 

managerul proiectului, compania care îl efectueaz� �i alte informa�ii privind categoria de 
proiecte în care se încadreaz�, comentarii, cuvinte cheie, leg�turi cu alte baze de date din 
meniul File → Properties, c�su�a Summary. 

 
Pasul 3. Pute�i seta planul de lucru privind zilele de lucru (�i cele libere) num�rul de 

ore de lucru al fiec�rei zile, intervalul de lucru din fiecare zi, pauzele, dac� e orar de zi sau de 
noapte, pute�i construi �i salva un orar propriu, îl pute�i predefini ca �ablon pentru construirea 
altor orare ulterioare etc, din meniul Tools → Change Working Time. 

 
Pasul 4. Se introduc activit��ile proiectului �i duratele lor. Pentru aceasta: 

a) se intr� în modul de vizualizare Gantt Chart (diagram� Gantt) din meniul View → 
Gantt Chart sau da�i clic pe butonul Gantt Chart      din bara View Bar (cea vertical� 
din stânga ecranului). Pentru a vedea aceast� bar� pe ecran bifa�i din meniul View 
op�iunea View Bar.  

b) Se selecteaz� din coloana Task Name pe rând fiecare linie �i se introduc succesiv 
numele tuturor activit��ilor proiectului. Dup� scrierea unui nume se d� ENTER. 

c) Se selecteaz� din coloana Duration pe rând fiecare linie �i se introduc succesiv duratele 
tuturor activit��ilor proiectului folosind bara derulant� din dreapta sau scriind efectiv 
durata în linia de editare (cea dintre barele de instrumente �i ecranul central). Dup� 
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introducerea unei durate se d� ENTER. Durata poate fi exprimat� în minute, ore, zile 
sau s�pt�mâni. În zile, durata minim� e jum�tate de zi (0.5 days). 

 
Pasul 4. (facultativ) Dac� o activitate se petrece de mai multe ori la intervale anume 

de timp (zilnic, s�pt�mânal, lunar, anual) selecta�i activitatea apoi intra�i în meniul Insert → 
Recurring Task. În c�su�a deschis� ve�i introduce numele activit��ii, durata, intervalul la 
care se petrece, pe ce perioada se manifest� aceast� repetare, de câte ori etc, apoi da�i OK. 

 
Pasul 5. (facultativ) O activitate poate fi întrerupt� �i reluat� mai târziu (de exemplu 

în cazul când este nevoie de resursele utilizate la aceasta pentru alt� activitate prioritar�). 
Pentru aceasta selecta�i activitatea respectiv� �i da�i clic pe butonul Split Task    din bara 
Standard (sau din meniul Edit alege�i op�iunea Split Task) apoi muta�i mouse-ul pe 
dreptunghiul ha�urat aflat în ecranul din dreapta în dreptul activit��ii respective, în interiorul 
activit��ii acolo unde vre�i s� apar� întreruperea �i da�i clic. Va fi introdus automat o 
întrerupere de o lungime predefinit� (de exemplu de 3 zile dac� durata e în zile). Dac� vre�i 
s� modifica�i lungimea acesteia pute�i muta buc��elele din activitate tr�gându-le cu mouse-ul. 
Pute�i de asemenea elimina întreruperea tr�gându-le una lâng� alta. 

 
Observa�ii: 

1. Pute�i rearanja activit��ile cu Cut – Paste, introduce activit��i noi între altele existente 
cu Insert – New Task sau �terge o activitate cu DELETE. 

2. Pute�i puncta evenimente importante prin introducerea, în locurile respective, de 
activit��i cu durata zero. 

 
Pasul 6. (facultativ) Se pot crea substructuri, sau subprograme, dac� proiectul este 

foarte complex �i presupune desf��urarea a foarte multe activit��i, grupate pe compartimente, 
echipe etc, sau se ob�ine prin integrarea sau condensarea a mai multe proiecte definite 
anterior. Pentru aceasta: 

1. Din bara View Bar, selecta�i Gantt Chart      . 
2. Din coloana Task Name selecta�i activitatea pe care vre�i s-o subordona�i sau s-o 

ridica�i în rang. 
3. Da�i clic pe Indent      pentru a subordona sau pe Outdent      pentru a ridica în 

rang activitatea.  
De asemenea pot fi ascunse sau vizualizate activit��ile unui subproiect din butoanele     

___, sau 
În plus, putem crea o coloan� nou� cu coduri proprii pentru activit��i (în afara celei 

predefinite ID) din meniul Insert → Column �i selectarea în câmpul Field Name op�iunea 
WBS (work brekdown structure. 

 
Pasul 7 . Se definesc dependen�ele dintre activit��i. Pentru aceasta se selecteaz� 

succesiv fiecare activitate �i apoi clic pe butonul Task Information     din bara Standard 
(sau dublu clic pe numele activit��ii, sau clic cu butonul drept pe numele acesteia �i alegerea 
op�iunii Task Information sau din meniul Project op�iunea Task Information. Se 
selecteaz� subcaseta Predecessors. În coloana Task Name se vor trece succesiv activit��ile 
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de care depinde activitatea curent�, în coloana Type tipul de dependen�� iar în coloana Lag 
întârzierea dependen�ei (eventual în procente din activitatea precedent�). 

 
Pasul 8. Dac� se iau în considerare �i resursele folosite atunci: 
I. Se creeaz� o list� cu resursele folosite cu toate informa�iile aferente acestora. 

Pentru aceasta: 
1. Din View Bar, da�i click pe Resource Sheet       . 
2. Din meniul View → Table bifa�i Entry. 
3. În coloana Resource Name tasta�i numele resursei. 
4. Dac� vre�i s� desemna�i un grup din care face parte resursa, introduce�i-i numele 

în coloana Group. 
5. Dac� este necesar, introduce�i num�rul maxim de unit��i disponibile din aceast� 

resurs� în coloana Max. Units, în procente (de exemplu, scrie�i 300% pentru a indica trei 
unit��i disponibile permanent din resursa respectiv�). 

6. Se modific�, dac� este cazul, �i valorile prestabilite ale celorlalte coloane. 
7. Repeta�i pa�ii de la 3 la 6 pentru fiecare resurs�. 

II. Succesiv pentru fiecare activitate se trec resursele folosite de acestea �i cantit��ile 
necesare. Pentru aceasta: 

1. Din bara View Bar, clic pe butonul Gantt Chart. 
2. Selecta�i succesiv fiecare activitate din coloana Task Name �i apoi da�i clic pe 

Assign Resources  
3. În coloana Name selecta�i succesiv resursele necesare activit��ii (pot fi selectate 

simultan utilizând SHIFT sau CTRL). 
4. În coloana Units trece�i procentul utilizat din resursa respectiv�. 
 
De asemenea, se poate da dublu clic pe numele resursei �i intra apoi în c�su�a 

Resources, cu acelea�i op�iuni de completat. 
 
Pasul 9. (facultativ) Se pot introduce informa�ii referitoare la resurse, privind 

costurile, ratele de schimb etc. În final se pot ob�ine informa�iile legate de costul întregului 
proiect din meniul Project – Project Informa�ion – Statistics  pe linia Current în dreptul 
coloanei Cost. 

 
Pasul 10. Se poate utiliza GanttChartWizard pentru a ob�ine rapid informa�ii 

despre proiect (de exemplu drumul critic) astfel: 
1. Din View Bar, clic pe Gantt Chart. 
2. Clic pe butonul       GanttChartWizard  din bara Standard. 
3. Urma�i instruc�iunile din GanttChartWizard. 
 
Pasul 11. Pute�i scoate la imprimant� proiectul dar este bine ca înainte de a printa s� 

utiliza�i Print Preview pentru a alege ceea ce va fi listat �i a�ezarea în pagin�. 
 
Pasul 12. Se poate personifica ecranul sau modifica aspectul graficelor, câmpurilor, 

fonturilor etc, din meniul Format. 
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Pasul 13. Din bara View Bar, selectând pe rând fiecare buton se pot ob�ine toate 
informa�iile necesare despre proiect (graful Gantt, graful PERT, utilizarea resurselor etc) 

 
Întreb�ri �i probleme 
 
1. Analiza�i problemele ridicate de disciplina managementul proiectelor în 

leg�tur� cu principalele forme �i structuri din cadrul organiza�iilor. 
 
2. Analiza�i instrumentele �i tehnicile puse la dispozi�ie de managementul 

proiectelor în contextul mediului în care lucra�i. Prezenta�i obiectivele clien�ilor 
�i ale companiei finan�atoare. 

 
3. Construi�i câteva exemple în care s� ar�ta�i cum se face structura repartiz�rii 

muncii în cadrul unui proiect �i modul în care este utilizat� aceast� metod� în 
cadrul managementului proiectelor. 

 
4. În orice organiza�ie de tip industrial sau din domeniul serviciilor ob�inerea 

resurselor pentru proiecte individuale este o problem� dificil�. Ar�ta�i modul în 
care se poate rezolv� aceasta în cadrul unei organiza�ii cu o structur� rigid�. 
Dar în cazul unei organiza�ii cu o structur� flexibil�? 

 
5. Din experien�a personal� prezenta�i un proiect. Justifica�i de ce exemplul 

prezentat poate fi privit ca un proiect. 
 
6. Explica�i de ce o organigram� matriceal� este adecvat� conducerii unui proiect. 
 
7. Discuta�i problemele ce pot s� apar� în cadrul unui proiect cu un sistem de 

raportare dual. 
 
8. Ce înseamn� un management semi-autonom în cadrul unui proiect? 
 
9. Care sunt caracteristicile minimale ce descriu un plan bun? 
 
10. Explica�i de ce trebuie elaborat mai întâi  planul strategic �i abia dup� aceea 

panul tactic. Analiza�i diferen�ele dintre aceste dou� tipuri de planuri. 
 
11. Discuta�i �i explica�i cele cele cinci concepte fundamentale ale managementului 

proiectelor. 
 
12. Explica�i urm�toarea afirma�ie: “Achizi�ia înseamn� cump�rare. Dar 

cump�rarea nu este achizi�ie.” 
 
13. Ce reprezint� riscul unui proiect? Cum difer� acesta de hazard? Exemplifica�i. 
14. Sugera�i care dintre zonele unui proiect sunt expuse întrr-o m�sur� mai mare 

riscului. 
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15. Explica�i: “Timpul necesar termin�rii unui proiect poate fi redus prin 

deplasarea resurselor.”    
 
16. Dou� opera�ii, A �i B, necesit� 24, respectiv 36 de unit��i de timp pentru 

execu�ie. Ini�ial cele dou� opera�ii sunt planiifcate a fi executate succesiv, B 
dup� A, ceea ce face ca timpul total   necesar s� fie de 60 de unit��i. Ar�ta�i 
grafic modul în care se pot suprapune cele dou� activit��i pentru a se reduce 
durata de execu�ie la 48 unit��i de timp. Analiza�i: 
• Consecin�ele manageriale; 
• Modul de utilizare a resurselor. 

 
17. Un manager de proiect a descoperit la o actualizare efectuat� dup� 250 de zile 

(pentru un proiect ce urma a fi executat în 1000 zile) c� activit��ile efectuate 
pân� atunci ar fi trebuit f�cute în 220 de zile. Determina�i indicele curent al 
îndeplinirii planului�i, presupunând c� nu vor surveni modific�ri semnificative 
ale performan�elor, estima�i timpul necesar pân� la finalizarea proiectului. 

 
18. Explica�i de ce costurile estimate de contabilul proiectului pot diferi 

semnificativ de cele estimate de contabilul organiza�iei finan�atoare. 
 
19. Dup� desf��urarea a trei luni din cadrul unui proiect, contabilul   a constatat c� 

din cele 75.000 USD programa�i a fi cheltui�i s-au cheltuit doar 60.000 USD. 
C�uta�i diverse motive pentru a explica aceast� situa�ie. 

 
20.  Fabricarea a patru piese pe trei ma�ini 

 
În fabricarea pieselor unui produs, ansamblul final (care este testat cu un aparat de 

m�sur� f�cut special) este compus din dou� p�r�i: 
 

1. Componenta D 
2. Al doilea ansamblu 

 
Al doilea ansamblu este compus din dou� p�r�i: 
1. Componenta C 
2. Primul ansamblu 
Primul ansamblu este format din dou� componente: 
1. Componenta A 
2. Componenta B 
Pentru a produce aceste componente trebuie ob�inute 3 ma�ini speciale care 

prelucreaz� componentele dup� cum urmeaz�: 
Prima ma�in� produce componenta A 
A doua ma�in� produce componenta B 
A treia ma�in� produce componenta C �i D 
 

01 
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Fiecare component� este testat� înainte de a fi asamblat� cu alt� component� sau 
articol, dar aparatul de testare este presupus a fi disponibil pentru toate testele cu excep�ia 
testului final, unde trebuie confec�ionat aparatul de m�sur� special. Proiectul acestui aparat 
de m�sur� special este cunoscut de la începutul întregului proiect. Activit��ile implicate în 
proiect sunt: 

Nr. 
crt. Activitate Durat� 

(în zile) 
1 Ob�inerea primei ma�ini 2 
2 Ob�inerea celei de-a doua ma�ini 3 
3 Ob�inerea celei de-a treia ma�ini 2 
4 Fabricarea componentei A 2 
5 Fabricarea componentei B 2 
6 Fabricarea componentei C 3 
7 Fabricarea aparatului de m�sura final 20 
8 Testarea componentei A 3 
9 Testarea componentei B 4 

10 Testarea componentei C 3 
11 Ob�inerea primului ansamblu 3 
12 Testarea primului ansamblu 5 
13 Fabricarea componentei D 8 
14 Testarea componentei D 20 
15 Ob�inerea celui de-al doilea ansamblu 7 
16 Ob�inerea ansamblului final 3 

  
Cerin�e: 
1. Face�i un program care s� arate intervalele în care activit��ile trebuie s� fie 

executate astfel încât proiectul s� fie terminat în timpul minim posibil. 
2. Desena�i o diagram� cu bare pentru proiect. 
 
21.   Nou� re�ele 
Desena�i urm�toarele 9 situa�ii (deoarece ele formeaz� partea unei re�ele mai mari 

nu trebuie s� existe neap�rat un unic nod de start sau de final). 
 
1. Activitatea K depinde de activit��ile A �i B 
2. Activit��ile K �i L depind de activit��ile A �i B 
3. Activitatea K depinde de activit��ile A �i B iar activitatea L numai de 

activitatea B 
4. Activitatea K depinde numai de activitatea A dar activitatea L depinde �i de A 

�i de B 
5. Activitatea K depinde de activit��ile A �i C iar activitatea L de activit��ile B �i 

C 
6. Activitatea K depinde de activit��ile A �i C, activitatea L de activit��ile B �i C 

�i activitatea M depinde numai de activitatea C 
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7. Activitatea K depinde de activitatea A, activitatea L depinde de activitatea B iar 
activitatea M de activit��ile A, B �i C 

8. Activitatea K depinde de activitatea A, activitatea L depinde de activit��ile A �i 
B iar activitatea M de activit��ile B �i C 

9. Activitatea K depinde de activitatea A, activitatea L depinde de activitatea A �i 
B iar activitatea M de activit��ile A, B �i C 

 
22.  Problema unei funda�ii  

 
La efectuarea unei construc�ii, pentru a putea turna betonul trebuie excavat 

p�mântul �i montate cofrajele. Cele trei activit��i au urm�toarele durate: 
 
 

Activitatea Durata (zile) 
Excavarea funda�iei 24 
Montarea cofrajelor 12 
Turnarea betonului 18 

 
Dac� cele trei activit��i sunt efectuate una dup� alta, fiecare activitate trebuind s� fie 

terminat� în totalitate înainte de a începe urm�toarea, atunci timpul total în care s-ar efectua 
proiectul ar fi de 54 de zile. Pentru a reduce acest timp s-a decis s� se înceap� montarea 
cofrajelor dup� excavarea doar a unei p�r�i din funda�ie �i turnarea betonului dup� montarea 
doar a unei p�r�i din cofraje. Desena�i diagrama A�A pentru situa�ia când activit��ile ar 
începe dup�: 

 
1. o jum�tate 
2. o treime 
3. un sfert 
din execu�ia activit��ii anterioare. Presupunem c� este disponibil doar o echip� care 

excaveaz� funda�ia, doar o echip� care monteaz� cofrajele �i doar o echip� care toarn� 
betonul �i c� aceste echipe nu pot fi divizate. Calcula�i durata total� de execu�ie în fiecare din 
cele trei cazuri �i apoi exprima�i-o ca procent din durata ini�ial� de 54 de zile. 

 
23. Preg�tirea unor schi�e 
În preg�tirea unui set de schi�e sunt implicate urm�toarele activit��i: 
 

Activitatea Durata (s�pt�mâni) 
Schi�area  12 
Desenarea 8 
Imprimare 4 

�eful echipei care face schi�ele este gata s� înmâneze schi�ele desenatorilor dup� 2 
s�pt�mâni iar desenatorii vor înmâna desenele spre printare dup� o s�pt�mân�. Desena�i 
diagrama acestei situa�ii. 

 
24. Diagrama Gantt 
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Desena�i re�eaua dat� prin: 
 

 Activitatea Activit��ile 
Succesoare Durata 

A D,E 4 
B F,C 6 
C G 2 START 

D L 3 
 E H 8 
 F H,K 9 
 G L 10 
 H L 6 
 K L 8 

FINISH L - 1 
 
Analizati aceasta retea si desenati diagrama Gantt. 
 
25. Repara�ia ma�inilor unelte 
Desena�i re�eaua corespunz�toare situa�iei urm�toare: 
Într-o uzin� sunt trei ma�ini unelte care trebuie mutate de pe soclurile lor pentru a fi 

modificate �i apoi reinstalate. Presupunând c� exist� o singur� echip� care poate executa 
mutarea ma�inilor, un singur mecanic care �tie s� efectueze modific�rile �i o singur� echip� 
capabil� s� reinstaleze ma�inile. 

 
Activit��ile implicate: 
Demontarea primei ma�ini 
Demontarea celei de-a doua ma�ini 
Demontarea celei de-a treia ma�ini 
Modificarea primei ma�ini 
Modificarea celei de-a doua ma�ini 
Modificarea celei de-a treia ma�ini 
Instalarea primei ma�ini 
Instalarea celei de-a doua ma�ini 
Instalarea celei de-a treia ma�ini 

 


